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Preface

Agile PLM is a comprehensive enterprise PLM solution for managing your product value 
chain. 

Audience
This document is intended for administrators and users of the Agile PLM products.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle Accessibility 
Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My 
Oracle Support. For information, visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle 
Technology Network (OTN) website 
http://www.oracle.com/technetwork/documentation/agile-085940.html contains the latest 
versions of the Agile PLM PDF files. You can view or download these manuals from the 
website, or you can ask your Agile administrator if there is an Agile PLM Documentation 
folder available on your network from which you can access the Agile PLM documentation 
(PDF) files. 

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated with an 
action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for which 
you supply particular values.



vi

monospace Monospace type indicates commands within a paragraph, URLs, code in 
examples, text that appears on the screen, or text that you enter.

Convention Meaning
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1Overview of Agile Database Installation

This chapter outlines the requisite tasks for successful installation of the Agile PLM Database 
and provides information on accessing the necessary software.

Task Overview
The sequence of tasks to install Agile PLM Database are listed below:

1. Prepare the installation environment. See "Agile System Requirements" on page 2-1.

2. Download the appropriate Oracle Database Server software. For download procedures, see 
"Obtaining Software from Oracle Support" on page 1-2 (for a Patchset/Minipack), or 
"Obtaining Software from Oracle Software Delivery Cloud" on page 1-1 (for a major 
release).

3. Install Oracle Database Server.

4. Download the Agile PLM Database Installer, which is part of the Agile PLM software 
distribution. See "Downloading the Agile PLM Software" on page 1-2.

5. Run the Agile PLM Database Installer. See "Installing and Configuring the Agile Database 
on Windows" on page 4-1 or "Installing the Agile Database on UNIX" on page 5-1.

Obtaining Software from Oracle Software Delivery Cloud
Major Oracle product releases are distributed as Media Packs on Oracle Software Delivery 
Cloud (http://edelivery.oracle.com). 

To obtain the Software:
1. Refer to the Media Pack description or the list of products that you purchased on your 

Oracle Ordering Document.

2. Review the Quick Install Guide License List to select the proper Product Pack.

3. Search for the appropriate Media Pack(s) that you must to download.

4. Verify the product you are looking for is in the License and Options section of the Product 
Pack README.

5. Proceed to download.

Note: There is an itemized part list within each pack and you must 
download all items to have the complete download for the desired Oracle 
Agile release.
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6. Review the Quick Install Guide License List to select the Product Pack you must to select 
and Search for the appropriate Media Pack(s) to download. 

. Then, Prior to downloading, verify that the product you are looking for is in the License and 
Options section of the Product Pack README. Oracle recommends that you print the 
README for reference.

There will be an itemized part list within each of the packs and you will need to download all 
items to have the complete download for the desired Oracle Agile release.

All Oracle Software Delivery Cloud files have been archived using Info-ZIP's highly portable 
Zip utility. After downloading one or more of the archives, you will need the UnZip utility or 
the WinZip utility to extract the files. You must unzip the archive on the platform for which it 
was intended. Verify that the file size of your downloaded file matches the file size displayed 
on Oracle Software Delivery Cloud. Unzip each Zip file to its own temporary directory.

Obtaining Software from Oracle Support
Oracle minor release products are distributed as a Patchset/Minipack, which is an electronic 
version of the software. To download the Product Patchset/Minipack, go to the My Oracle 
Support at https://support.oracle.com website and search for the product. Refer to the 
description and review the Readme. After you review the Readme, download the Product 
Patchset/Minipack.

There will be one zip file which contains all Product binaries, documentation, and database 
files. Follow the installation instructions from the Install Guide to install the product.

Downloading the Agile PLM Software

To download the software from Oracle Support:
1. Log in and perform a search for the product using the search parameters provided.

2. Click the Download Now icon to download the software.

3. Extract the contents of the media pack and navigate to the DB_Installer folder. DB 
installers for all platforms regardless of the operating system on which you have chosen to 
install Agile PLM, are available in the DB_Installer folder.
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2Agile System Requirements

You can deploy the Agile PLM in different configurations. The length of time to complete an 
installation depends on the complexity of your Agile PLM deployment.

You can install the Agile PLM in a distributed environment, over a wide-area network with 
multiple servers, or limited to one or two server computers with several client computers. In the 
latter case, you can install Agile in a shorter period, approximately within a half day. 
Network-based systems are inherently complex, and installations require additional time.

It is acceptable to install multiple server components on the same computer if sufficient 
hardware resources are available. However, you must increase the minimum hardware 
requirements based on the number of server components installed on a single computer.

For a complete list of hardware and software requirements, refer to the Agile PLM Capacity 
Planning Guide.

Note:  For installations using a certified localized language, all server 
components must be installed on computers running the same localized 
operating system. Clients can be running on the same localized or English 
operating system. For detailed information about using Agile with 
international operating systems, refer to the Agile support website: 
http://www.oracle.com/agile/support.html.

Note: Oracle recommends installing the Oracle Database Server on a 
separate computer from the other Agile components.
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3Installing Oracle Database Server

Before you install the Agile database, you must install the Oracle Database Server. You can 
download the Oracle Database Server Installer for major releases from Oracle Software 
Delivery Cloud at: http://edelivery.oracle.com, and for a Patchset/Minipack, from Oracle 
Support at: https://support.oracle.com. Download instructions for each Oracle version/operating 
system are provided in the download page.

For detailed instructions on installing a specific version of the Oracle Database Server, refer to 
the applicable version of the Installation Guide in Oracle Documentation at: 
http://www.oracle.com/technetwork/documentation/index.htm.

Related Documentation
Before you begin, it is important to be familiar with all the information about installing the 
Oracle database on different operating systems, and with the Optimal Flexible Architecture 
(OFA) reference material for administrators. You can review the information pertaining to your 
Oracle database server version at Oracle Documentation at: 
http://www.oracle.com/technetwork/documentation/index.html.

Agile has made every effort to be OFA-compliant. Any deviations from OFA guidelines are 
noted.

Before Installing Oracle Database Server on Windows
Before installing Oracle, you must:

� Verify that Windows is configured correctly.

� Check to see that the Microsoft NTFS file system is used instead of FAT or FAT32, and 
convert the file system if necessary. See "Checking the Windows File System" on page 3-2 
for directions.

� Determine the name of the Windows computer where you plan to install Oracle.

Note: After you install Oracle Database Server, you must install the 
Example products into your ORACLE_HOME, available at the download 
location. In an Oracle RAC environment, these products are installed on all 
nodes. These products include some files that required to successfully create 
the Agile schema.

Note: Make sure you select the database binaries that are compatible with 
the hardware you are using.
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� Be sure that you have Administrator privileges within Windows on the computers where 
you are installing Oracle and Agile PLM.

� Disable disk compression, if you are using it.

� Disable virus protection, if you are using it. Components used in the installer can be falsely 
identified as being infected and lock up the installation. You can turn the virus protection 
on after the installation is complete.

The following sections provide more information about these procedures.

Checking Network Settings
Before proceeding, it is important to confirm the following two settings to prevent difficulties 
from occurring.

Confirming the Computer Name and the Host Name
The computer where Oracle is installed must use the same value as both its computer name and 
its DNS host name. You can use the following procedures to identify the current values.

To verify the computer name for Windows environments:
1. On the Desktop, right-click the My Computer icon and choose Properties in the shortcut 

menu.

2. In the System Properties dialog box, click the Computer Name tab.

3. Check the name in the Full Computer Name field.

Confirming the Server Date
It is important to adjust the server’s date and time fields. The date and time must be correct 
when you work with your production data.

To confirm the date and time, click the Date/Time icon in the Windows Control Panel. Be sure 
to verify the Time Zone setting as well.

Checking the Windows File System
Agile recommends that servers use NTFS (NT File System) rather than FAT or FAT32 (File 
Allocation Table), as NTFS is more robust.

Note: It is recommended that the computer on which you are installing the 
Oracle database have at least two physical drives or two partitions. This 
enables you to place the operating system on the C drive and use the D drive 
for Oracle components. The examples in this chapter use a C and D drive.

Note: Windows uses the same name for the computer name and DNS host 
name.

Caution:  If you change the date or time after Agile PLM has been 
installed and started, you need to stop and restart the server immediately after 
the change.
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To determine the type of the file system: 
1. Check the file system used on the computer. Choose Start > Administrative Tools > 

Computer Management. Under Computer Management in the left pane, expand 
Storage and select Disk Management.

The Disk Administration window opens.

There must be at least two partitions or hard drives. If your computer uses NTFS, proceed 
with the Oracle installation. If your computer uses a FAT or FAT32 file system, Agile 
recommends converting it to NTFS before proceeding.

2. Right-click the drive that you want to reformat and select Format in the shortcut menu.

3. In the File System field, change the file system type to NTFS.

4. Click Start.

The process takes several minutes. On completion, restart the system. You can proceed 
with the Oracle installation.

For Servers Configured with DHCP
If your server is configured with DHCP (Dynamic Host Configuration Protocol), there is a 
known issue with the Oracle Database Server installation. The installation fails and a warning 
message displays.

There are two possible solutions:

� Copy the Oracle Database Server installation software to your local disk and perform an 
off-network installation.

� Install the Microsoft Loopback adapter on the DHCP server and then add one entry to the 
hosts file.

To install the Microsoft Loopback adapter:
1. Click Start > Control Panel > Add Hardware.

The Add Hardware wizard appears.

2. Click Next.

3. Choose Install the hardware that I manually select from a list (Advanced), and then 
click Next.

4. In the Common Hardware Types list, select Network adapters, then click Next.

5. In the Manufacturers list, select Microsoft.

6. In the Network Adapter list, select Microsoft Loopback Adapter, and then click Next.

7. Click Next to install the adapter.

8. Click Finish.

To configure the hosts file:
1. Open the hosts file located at C:\Windows\System32\drivers\etc.

2. Add the following entry to the hosts file: 10.10.10.10 <host name>.<domain host name>

Important: Converting the file system deletes all current files on the drive. 
Backup all necessary files before converting the file system to NTFS.
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For example, if the full system name of your database server is db1.agile.agilesoft.com, the 
entry in the hosts file is:

10.10.10.10 db1.agile.agilesoft.com db1

3. Save the file.

To configure the loopback IP address on the network:
1. On the database server, right-click the My Network Places icon.

2. Choose Properties to display the Network and Dial-up Connections window.

3. Locate a connection with device name Microsoft Loopback Adapter. This connection is 
usually the Local Area Connection 2.

4. Right-click this connection icon.

5. Choose Properties to display the Local Area Connection 2 Properties dialog box.

6. On the General tab, select Internet Protocol (TCP/IP), then click Properties to display 
the Internet Protocol (TCP/IP) properties dialog box.

7. On the General tab, choose Use the following IP Address.

8. Enter the following values:

IP address: 10.10.10.10

Subnet mask: 255.255.255.0

9. Click OK.

10. Click Close.

On completion, restart the system. You can proceed with the Oracle installation.
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4Installing and Configuring the Agile Database
on Windows

[2] This chapter provides procedural as well as other necessary information to install the Agile 
database in a Windows environment.

Installing the Agile Database on Windows
For best results, note the following recommendations during installation:

� Follow directions in the order in which they are given. Do not attempt to install any 
components out of sequence.

� Oracle passwords and Agile passwords are case-sensitive. All other text entries, such as 
schema names and folder names, are not case-sensitive. To avoid confusion, all passwords 
and text entries in this guide appear in lowercase and should be typed as shown.

� When prompted for a host name, type the fully qualified name for the host, not the short 
name. For example, if a host is called dbo, type dbo.agile.com and not dbo.

To install the Agile database on Windows:
1. Within the DB_Installer folder, double-click the agile9360db_oracle.exe file to start the 

installation on Windows. The Agile Database Configuration Utility appears

2. Follow the instructions in "Configuring the Agile Database on Windows" on page 4-1 to 
configure the database.

3. Complete the post installation steps described in "Database Postinstallation Tasks" on 
page 6-4.

Configuring the Agile Database on Windows
The Agile Database Configuration Utility creates and configures the database used by Agile. 
To start this utility, go to the DB_Installer folder and double-click the database installer 
executable file,agile9360db_oracle.exe. 

The Drop-down list displays the available disk space on the selected disk. If the space is a 
negative value, you must select another drive. 

Note: If you change a default value, you must check the data field to ensure 
the change is properly made.
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To configure the database:
1. In the Destination Location dialog box of the Database Configuration Utility, accept the 

default location, Agile9Tmp, or click Browse to specify a destination of your choice. This 
is the location where template files are placed during the database installation. Throughout 
this document, this location is named Agile9Tmp. Click Next.

2. In the Oracle home dialog box, choose the applicable ORACLE_HOME. This is the 
location that the Oracle software is installed. If you have multiple Oracle homes, make sure 
the correct Oracle home is selected before continuing with the Database Configuration 
Utility. Click Next.

3. In the Oracle SID dialog box, accept the default agile9 SID. If you want to change the SID, 
you must use an ID that is 4 to 8 characters in length to uniquely identify the Oracle SID. If 
you want to use an existing SID, you must remove it before you can reuse it. Click Next.

4. In the Database Security and Agile User Information dialog box, set the Internal/Sys 
password, SYSTEM password, CTXSYS password, Agile Schema Name, and Agile 
Schema Password. Each password must be at least 6 characters long. Click Next.

5. In the Database Size Estimate dialog box, choose a database sizing model. New Agile 
customers without an existing database to migrate should accept the default (Small). Click 
Next.

You can reselect a database sizing model depending on disk space available.

6. In the Tablespaces dialog box, accept the default, unless you have additional hard drives 
with sufficient space available that allow you to distribute the files across multiple hard 
drives. If you change the selection to a different drive location, click the letter of the drive 
to make sure it is selected. Click Next.

7. In the Redo Log Files and Control Files dialog boxes, accept the default, unless you have 
additional hard drives with sufficient space available that allow you to distribute the files 
across multiple hard drives. Click Next.

8. If you accept the default location for the files on one drive, a message appears notifying 
you about distributing the files across multiple drives (mirroring protection). If this is not 
an option, click Next. Otherwise, click Back and reassign files to different hard drives.

9. In the Archive Log File dialog box, accept the default, unless you have additional hard 
drives with sufficient space available that allow you to store the file on a different hard 
drive. Click Next.

10. In the Oracle Language Support dialog box, configure the NLS_LENGTH_SEMANTICS 
parameter to determine data type storage allocation by the database server. The default 
value is CHAR. 

11. Click Next and accept the default character set AL32UTF8. 

12.  Click Next.

Note: If you only want to generate database scripts (for example, to 
upgrade an existing Agile schema), select the Generate database scripts 
only option. In this case, you should use an existing SID. Follow on-screen 
directions to generate scripts.

Note: Refer to the Agile PLM Capacity Planning Guide for database sizing 
information.
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A Command Prompt window briefly appears.

13. You are prompted to install the Agile database. Click Next.

The script runs in a Command Prompt window for a while.

14. When instance creation is complete, a confirmatory message appears. Click OK to 
complete the process and exit.

Agile supports Full Text Search (FTS). FTS is a feature enabled through Oracle Text. Because 
of this feature, there is a fixed account, CTXSYS, referenced by some objects in the Agile 
schema. For security purposes, you can change the CTXSYS account password from its 
default, CTXSYS, to one of your own choice after Agile database creation and configuration.

Note: For additional information about language support, refer to the 
Oracle Globalization Support Guide.

Note: Oracle recommends that you change all Oracle database user 
passwords after you have created the Agile database. It is recommended to 
change these passwords periodically for security purposes
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5Installing the Agile Database on UNIX

This chapter provides background and procedural information to install the Agile database in a 
UNIX environment.

Preparing the Host Computer
This section describes how to prepare the installation environment on UNIX. Preparing the 
installation environment involves copying the Agile database utilities.

To copy Agile Database utilities:
1. Log in as the user who installed the Oracle database software and create a temporary 

directory called "agile9360db:"

$ mkdir /home/oracle/agile9360db [Enter]

2. Download the appropriate Agile PLM media pack for your operating system to the 
agile9360db directory. For more information to obtain the media pack, see "Obtaining 
Software from Oracle Support" on page 1-2 (for a Patchset/Minipack), or "Obtaining 
Software from Oracle Software Delivery Cloud" on page 1-1 (for a major release).

3. Change to the DB_Installer directory, and extract the files from the agile9360db_
oracle.tar.gz file:

$ cd /home/oracle/agile9350db [Enter]

$ gunzip -c agile9360db.tar.gz|tar xvf - [Enter]

The agile9360db_oracle.tar contains the following files:

� agile9database.sh - shell script for creating the database instance and generating the 
database maintenance scripts

� agile9schema.dmp - agile schema dump file

� dbora - setup for the database automatic shutdown and startup

� pdqplm_plsql.jar - Java stored procedures for the Enterprise Data Quality Product 
integration

� profile.txt - oracle user .profile template

� Readme.txt - readme file

� system.txt - Solaris kernel parameters
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Creating the Agile Database on UNIX
This section describes how to set up the Oracle environment variables and create the default 
database instance and the schema used by Agile in conjunction with the Agile database creation 
utility.

To set up Oracle environment variables
1. Log in as the user that was used to install the Oracle database software..

2. Create the environment parameter file .profile to include:

PATH=$PATH:/usr/local/bin:/usr/ccs/bin:/usr/openwin/bin:/usr/bin/X11
export PATH
ORACLE_HOME=<Location where you installed Oracle Database Server>
export ORACLE_HOME
SHLIB_PATH=$ORACLE_HOME/lib
export SHLIB_PATH

For example:

(Oracle 11g)ORACLE_HOME=/u01/app/oracle/product/11.1.0/db_1;export ORACLE_HOME
ORACLE_BASE=<Oracle base folder location:;export ORACLE_BASE

For example:

ORACLE_BASE=/u01/app/oracle;export ORACLE_BASE
PATH=$PATH:$ORACLE_HOME/bin;export PATH
ORACLE_SID=agile9;export ORACLE_SID
NLS_LANG=AMERICAN_AMERICA.AL32UTF8;export NLS_LANG

3. The environment variables settings above are stored in the file profile.txt included with the 
Agile database utilities. If this is the first time you are configuring the host computer as a 
database server, copy the profile.txt file to .profile:

$ cat agile9350db/profile.txt > .profile [Enter]

4. Set environment variables:

$ . ./.profile [Enter]

To start the installation: 
1. Log in to the computer as the user you created while preparing the installation 

environment. For example, Oracle.

a. If necessary, edit the .profile file to change Oracle SID. By default, Agile uses agile9 as 
the Oracle SID:

$ vi .profile [Enter]

b. Modify the value where ORACLE_SID=agile9 by replacing agile9 with the SID you 
want to use. 

Important: Check the /var/opt/oracle/oratab file and ensure that the 
specified Oracle SID has not been used. Specifying an existing Oracle SID 
can corrupt that database instance.
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c. Source .profile to make the SID changes take effect:

. ./.profile [Enter]

2. In a second terminal session, log in to the computer as the root user.

3. Create a directory and call it "oradata."

For example, if you have mount points at /u01 and /u02, you can create an oradata folder 
on each mount point.

# mkdir -p /u01/oradata

# chown oracle:dba /u01/oradata

4. In the session where you are logged in as the Oracle user, create a $ORACLE_
BASE/admin directory:

$ mkdir -p /u01/app/oracle/admin [Enter]

(Assuming ORACLE_BASE is set to /u01/app/oracle.)

chown -R oracle:dba /u01/app/oracle

Now run the agile9database.sh script.

5. Change to the /home/oracle/agile9350db directory.

6. Modify the agile9database.sh script to match the mount points on your computer.

The values in the script that can be modified appear in bold. You should limit your editing 
only to these bold values.

The following code lists variables in bold that you may want to revise besides placeholder 
mount point /mpt:

#!/bin/sh

.

.

.

# AGILE9DB_BASE is the base directory for the OFA directories and maintenance scripts

# (create the directory before running this script)

Note: The recommended SID length is 4-8 alphanumeric characters. (The 
default SID 'agile9' is six characters.)

Note: The agile9database.sh file uses a placeholder mount point /mpt. You 
must change /mpt to match your mount points.

Note: Make sure ORACLE_SID matches the one you set for .profile, 
which took effect after you ran . ./.profile.

Note: The agile9database.sh file uses a placeholder mount point /mpt. You 
must change /mpt to match your mount points.
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# (default is $ORACLE_BASE/admin/$ORACLE_SID)

#

AGILE9DB_BASE=$ORACLE_BASE/admin/$ORACLE_SID

# Parameters determine location of datafiles, # controlfiles and logfiles

#

DATABASE_SYSTEM=/mpt/oradata/${ORACLE_SID} # SYSTEM tablespace mount 
point

DATABASE_SYSAUX=/mpt/oradata/${ORACLE_SID} # SYSAUX tablespace mount 
point

DATABASE_TOOLS=/mpt/oradata/${ORACLE_SID} # TOOLS tablespace mount point

DATABASE_UNDO=/mpt/oradata/${ORACLE_SID} # RBS tablespace mount point

DATABASE_TEMP=/mpt/oradata/${ORACLE_SID} # TEMP tablespace mount point

DATABASE_USERS=/mpt/oradata/${ORACLE_SID} # USERS tablespace mount point

DATABASE_INDX=/mpt/oradata/${ORACLE_SID} # INDX tablespace mount point

DATABASE_AGILE_DATA1=/mpt/oradata/${ORACLE_SID} # AGILE_DATA1 
tablespace mount point

DATABASE_AGILE_INDX1=/mpt/oradata/${ORACLE_SID} # AGILE_INDX1 
tablespace mount point

DATABASE_AGILE_DATA2=/mpt/oradata/${ORACLE_SID} # AGILE_DATA2 
tablespace mount point

DATABASE_AGILE_INDX2=/mpt/oradata/${ORACLE_SID} # AGILE_INDX2 
tablespace mount point

DATABASE_AGILE_DATA3=/mpt/oradata/${ORACLE_SID} # AGILE_DATA3 
tablespace mount point

DATABASE_AGILE_INDX3=/mpt/oradata/${ORACLE_SID} # AGILE_INDX3 
tablespace mount point

DATABASE_AGILE_DATA4=/mpt/oradata/${ORACLE_SID} # AGILE_DATA4 
tablespace mount point

DATABASE_AGILE_INDX4=/mpt/oradata/${ORACLE_SID} # AGILE_INDX4 
tablespace mount point

DATABASE_AGILE_DATA5=/mpt/oradata/${ORACLE_SID} # AGILE_DATA5 
tablespace mount point

DATABASE_AGILE_INDX5=/mpt/oradata/${ORACLE_SID} # AGILE_INDX5 
tablespace mount point

DATABASE_LOGFILES1=/mpt/oradata/${ORACLE_SID} # REDOLOG file 1 mount 
point

DATABASE_LOGFILES2=/mpt/oradata/${ORACLE_SID} # REDOLOG file 2 mount 
point

DATABASE_LOGFILES3=/mpt/oradata/${ORACLE_SID} # REDOLOG file 3 mount 
point

DATABASE_LOGFILES4=/mpt/oradata/${ORACLE_SID} # REDOLOG file 4 mount 
point
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DATABASE_CONTROL1=/mpt/oradata/${ORACLE_SID} # CONTROL file 1 mount 
point

DATABASE_CONTROL2=/mpt/oradata/${ORACLE_SID} # CONTROL file 2 mount 
point

DATABASE_CONTROL3=/mpt/oradata/${ORACLE_SID} # CONTROL file 3 mount 
point

DATABASE_ARCHIVE=/mpt/oradata/${ORACLE_SID}/arch # ARCHIVELOGS

#

# Parameters determining: Character Set

#

CHARACTER_SET=AL32UTF8

NATIONAL_CHARACTER_SET=AL16UTF16

NLS_LANG=American_America.AL32UTF8

#

7. Run the agile9database.sh script from the current directory:

$ ./agile9database.sh [Enter]

8. You are prompted to choose the Install Mode. Type I to create the database instance, S to 
only generate maintenance scripts, or q to quit the installation. [Enter]

9. Type the Agile PLM Instance name (ORACLE_SID). The default is agile9. If you want to 
change the SID, you must use an ID that is 4 to 8 characters in length to uniquely identify 
the Oracle SID. [Enter]

10. Type the Agile PLM Schema Name. The default is agile.[Enter]

11. The next four prompts allow you to add passwords for the Agile PLM, SYS, SYSTEM, 
and CTXSYS schemas. Each password must be at least 6 characters in length. [Enter]

12. You are prompted about the database size that you want to install.

You should use the small database size unless you have consulted with an Agile Solutions 
Consultant or database administrator to ensure that the computer meets the minimum 
requirements for the specified database size.

13. Choose the NLS_LENGTH_SEMANTICS parameter to determine data type storage 
allocation by the database server. The default value is CHAR. [Enter]

14. Verify the values you have typed, and then type I to install.

The script will run for a while.

Note: If you are unable to create files, ensure that all Oracle environment 
variables are set correctly and that the 'oracle' user has full (read, write, and 
execute) privileges on all directories referenced by agile9database.sh.

Note: Oracle recommends that you change all Oracle database user 
passwords after you have created the Agile database. It is recommended to 
change these passwords periodically for security purposes
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6Creating an Oracle RAC Database and Schema
for Agile PLM

You can create an Oracle Real Application Clusters (RAC) database instance for Agile PLM 
using the Oracle Database Configuration Assistant (DBCA), and then create an Agile PLM 
schema in that database instance. This chapter provides the necessary information to perform 
these tasks.

Creating an Oracle RAC Database Instance for Agile PLM
To create an Oracle RAC database instance:
1. Start the Oracle Database Configuration Assistant. (From the Start menu, navigate to All 

Programs > Oracle - <Oracle home> > Configuration and Migration Tools, and 
choose Database Configuration Assistant). The Database Configuration Assistant: 
Welcome dialog appears.

2. Select the Oracle Real Application Clusters database option. Click Next.

3. In the Operations dialog, select Create a Database. Click Next.

4. In the Node Selection dialog, select all Oracle RAC nodes. Click Next.

5. In the Database Templates dialog, select Custom Database. Click Next.

6. In the Database Identification dialog, enter values for the Global Database Name and SID 
Prefix. For example, RAC.WORLD and RAC. Click Next.

7. In the Management Options dialog, click Next to accept the default selections. For more 
information on Oracle Enterprise Manager, see related documentation on the Oracle 
Technology Network (OTN) website 
http://www.oracle.com/technetwork/documentation/agile-085940.html.

8. In the Database Credentials dialog, choose the Use the Same Password for All Accounts 
option. You can change the passwords later. Enter a password and confirm it. Click Next.

9. In the Storage Options dialog, select your preferred storage option. The storage option that 
you have on your system is automatically detected and appears selected. Click Next. Based 
on your selection, the Database Configuration Assistant will present further options. 
Follow on-screen directions to configure storage details.

10. Next, select the database components you require. In the Database Content dialog, under 
Database Components, select the following:

� Oracle Data Mining

� Oracle Text
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� Enterprise Manager Repository (Optional)

Click Next.

11. In the Database Services dialog, to accept the current configuration details, click Next.

12. In the Initialization Parameters dialog, under Memory, select Custom. Provide desired 
SGA and PGA sizes or accept the default. Click Next.

13. In the Database Storage dialog, select the Tablespaces node. Create the following 
tablespaces in the instance.

� AGILE_DATA1

� AGILE_DATA2

� AGILE_DATA3

� AGILE_DATA4

� AGILE_DATA5

� AGILE_INDX1

� AGILE_INDX2

� AGILE_INDX3

� AGILE_INDX4

� AGILE_INDX5

14. Review storage parameters and click Next to accept.

15. In the Creation Options dialog, Create a Database is the default selection, and then click 
Finish to accept database creation settings.

16. In the Summary screen, click OK to initiate the database creation process.

17. Once the database creation is complete, a dialog appears with details of the newly created 
database instance. Make a note of the information for your records. Within this dialog, 
click Password Management and do the following:

a. Make sure that the CTXSYS account is not locked. If it is locked, log in to Oracle as 
'sys' or 'system' and execute this SQL command:

alter user ctxsys account unlock;

b. Set the following account passwords:

�  system / manager

� ctxsys / ctxsys

�  sys / oracle

You can change the passwords after schema creation is complete.

Note: At any stage, to change your selections, click Back and navigate to 
the appropriate dialog.

Note: Data files should be sized at least 1GB each with autoextend enabled, 
and must be named as listed above. You can store the data file at any location 
on your hard drive. 
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18. Click Exit. The Oracle RAC database instance creation is now complete.

Creating Agile PLM Schemas in Existing Oracle RAC or 
Standalone Database Instance

The Oracle database stores data in virtual containers known as schemas. The Agile Database 
Configuration Utility creates the database, user account, and schema used by Agile. Additional 
schemas are not necessary; however, you can create additional Agile schemas with different 
user names if necessary.

To create a schema in the Oracle RAC Database Instance:
On UNIX:

1. Run agile9database.sh and then select the Generate Maintenance Scripts Only option to 
generate the Agile PLM 9.3.6 schema maintenance scripts.

2. Run recreateagile.sh to create the schema.

On Windows:

1. Run the database installer, described in "Installing and Configuring the Agile Database on 
Windows" on page 4-1.

2. In the installer screen where you specify the Oracle SID, select the Generate Database 
Scripts Only check box. See Step 3 under "Configuring the Agile Database on Windows" 
on page 4-1

3. Follow on-screen instructions to generate the scripts.

4. Run recreateagile.bat to create the schema.

There are three requirements around the package SYS.DBMS_SHARED_POOL for an Agile 
database. If the requirements are not met, and the package DBMS_SHARED_POOL does not 
exist in the SYS schema, you may receive a DBMS shared pool error or AGILE9_UTILS error.

To ensure DBMS_SHARED_POOL requirements are met
1. Log in to the database as 'sys' user.

2. Run the following command:

SQL> describe SYS.DBMS_SHARED_POOL

3. If you receive an error indicating the object SYS.DBMS_SHARED_POOL does not exist, 
run the SQL script dbmspool.sql located at ORACLE_HOME/RDBMS/admin.

4. As 'sys' user, grant execute privileges to the agile schema user.

SQL> grant execute on SYS.DBMS_SHARED_POOL to AGILE;

Where AGILE is the agile schema user.

5. Connect to the database as the agile schema user, and run the following command:

SQL> create synonym DBMS_SHARED_POOL for SYS.DBMS.SHARED_POOL;

6. When the process completes, run the following command to compile the AGILE9_UTILS 
package:

Note: You should not use the Oracle Security Manager to create users.
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SQL> alter package agile9_utils compile body;

The package should compile without errors. If the package compiles with errors, run the 
following command and correct the same:

SQL> show errors

Database Postinstallation Tasks
This section describes mandatory and optional postinstallation tasks to be completed, such as 
configuring Oracle network connectivity and setting up additional Oracle functionality.

Adding and Configuring a Listener
If this is the first time Oracle has been installed on the current computer, you need to add and 
configure a new database listener.

To add and configure a new Listener:
1. Start Oracle Net Manager:

On Windows, choose Start > All Programs > <ORACLE_HOME> > Configuration 
and Migration Tools > Net Manager.

On UNIX, run the command $ netmgr &.

2. In the Oracle Net Manager window, double-click the Local folder and select the Listeners 
folder.

3. Click Create in the toolbar to add a listener.

The Choose Listener Name dialog box appears.

4. Click OK.

5. In the Listening Locations drop-down list, select Database Services.

6. Click Add Database.

In the dialog box that appears, make the following changes:

Global Database Name: agile9

Oracle home Directory: <ORACLE_HOME>

SID: agile9

7. Choose File > Save Network Configuration to save your changes.

8. Close Oracle Net Manager.

To restart the database listener, open a Command Prompt window and type lsnrctl reload.

Note: If you are creating a new Agile database on the same computer, you 
only need to add the new database to the existing listener.

Note: If you used a different global database name or different home 
directory during the database installation, change the information as 
appropriate.
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Adding and Configuring a Net Service
1. In the Oracle Net Manager window, double-click the Local folder and select the Service 

Naming folder.

2. Click Create in the toolbar to add a service name.

The Net Service Name Wizard starts.

3. In the Net Service Name field, type the name of the computer where the Oracle database 
is located (usually the current computer). Click Next.

4. When prompted to select a network protocol, select TCP/IP (Internet Protocol) and then 
click Next. 

5. Type the name of the computer where Oracle is located in the Hostname field (the same 
name you typed in step 3). Accept 1521 as the default port number. Click Next.

6. Select Oracle8i or later as the service name, and type agile9 in the field. Click Next.

7. Click Test to test the service.

The test initially fails because the default uses the incorrect login.

8. Click Change Login to reset the username and password.

9. Type agile in the Username field and tartan in the Password field. Click OK.

10. Click Test. You should now see a message indicating that the test was successful.

11. Click Close.

12. Click Finish to exit the Net Service Name Wizard.

13. From the Net Manager menu, choose File > Save Network Configuration to save the 
service name.

Setting Up Automatic Shutdown and Startup on the UNIX Database

To set up the Oracle database to automatically shut down/start when host 
computer starts/shuts down:
1. Log in the system as root.

2. Create a file named "dbora" in the /etc/init.d directory:

# cat /home/oracle/agile9350db/dbora > /etc/init.d/dbora [Enter]

3. Link to the dbora file:

# ln -s /etc/init.d/dbora /etc/rc0.d/K10dbora [Enter]

# ln -s /etc/init.d/dbora /etc/rc2.d/S99dbora [Enter]

Setting Up Optional Oracle Functionality
This section describes how to set up Oracle Net Manager and Oracle Enterprise Manager for 
administrative purposes.

Setting Up Oracle Net Manager
If you use the TNS_ADMIN environment variable to specify the location of Oracle Network 
Services configuration files (such as tnsnames.ora), move the files located in the $ORACLE_
HOME/network/admin directory to the directory specified by TNS_ADMIN.
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To set up Oracle Net Manager on UNIX:
1. Log in as root and change the ownership of the /var/opt/oracle directory:

# chown -R oracle:dba /var/opt/oracle [Enter]

2. Switch to the Oracle user, and change to the $ORACLE_HOME/network/admin directory:

# su - oracle [Enter]

$ cd $ORACLE_HOME/network/admin [Enter]

3. Move all the files to the directory defined by environment parameter TNS_ADMIN, which 
is /var/opt/oracle:

$ mv * /var/opt/oracle [Enter]

Configuring Oracle Enterprise Manager
You can use Database Control to perform many database administration and management tasks 
including SQL performance tuning.

To configure the Oracle network connection:
1. On Windows: Choose Start > AllPrograms > Oracle - <ORACLE_HOME> > 

Configuration and Migration Tools > Database Configuration Assistant.

On UNIX: Run the command $ dbca &.

The Welcome screen appears.

2. Click Next.

3.  Choose Configure Database Options on the Operations page. Click Next.

The Database page appears

4. Select the agile9 database you just created. Click Next.

The Management Options page appears.

5. Check Configure the Database with Enterprise Manager. Click Next.

The Database Content page appears.

6. Accept the defaults. Click Next.

The Database Credentials page appears.

7. Enter a password for the DBSNMP and SYSMAN users. Click Next.

The Connection Mode page appears.

8. Select Dedicated Server Mode. Click Finish.

9. Click OK for confirmation. Database configuration begins.

When configuration completes, the Database Control URL displays. Make a note of this 
URL because it is how you log in to the database.

10. Click OK to close the Database Configuration Assistant.

11. Open a web browser and enter the Database Control URL.

12. Type the User Name and Password of the Agile database. Click Login.

13. Click I agree to accept the license agreement and display the Database Control page.

You have completed installing and configuring the Agile PLM Database.
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Setting Lexer Preference
Based on your installation requirement, you have the option to choose either BASIC lexer or 
WORLD lexer. The default lexer is BASIC. To overcome FTS limitations related to character 
searches, customers using the Japanese lexer should change from BASIC to WORLD lexer.

To switch lexer preference:
1. Stop the application server.

2. Run the database installer with the Generate maintenance scripts option selected.

3. Edit recreateagile.bat to switch the lexer, by changing agile9_fts_prefs_lexer_basic.sql to 
agile9_fts_prefs_lexer_world.sql

4. Run recreateagile.bat.

5. Import customer data.

6. Restart the application server.

Setting up Enterprise Data Quality Product Integration
Complete the following steps.

To set up integration between Enterprise Data Quality Product and Agile PLM:
1. Enable Oracle JVM.

2. Run the agile9pdq_setup file, located in the $ORACLE_BASE\admin\SID\create\agile 
directory.
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7Managing the Database

It is important to protect your Agile data and system files from loss. This section describes 
basic backup and recovery strategies and gives specific information about applying them to 
your Agile system used with Oracle products.

The instructions in this section are for system and database administrators who need to manage 
the Agile database.

Database Maintenance
This section provides database maintenance procedures.

Monthly Maintenance
As part of monthly maintenance activities, Oracle recommends the following:

� Rebuilding domain indexes to improve performance.

� Running Averify to check database integrity and tablespace free space.

Checking Database Space Allocation
Checking the tablespace data files in your Oracle database on a monthly basis can help 
determine how close your database storage is to maximum capacity. If any or all of the 
tablespaces are at least 90 percent, you should increase the disk space allocation for the specific 
tablespaces. One method for accomplishing this is to increase the data file size for the 
corresponding tablespaces, as follows:

To increase the disk space for Oracle databases:
1. Check the disk space for the hard drive where the Oracle database is located.

2. If there is less than 500 MB available, it is recommended that you increase disk space by 
adding to or replacing the hard drive.

3. To check the tablespace data files, start the Enterprise Manager Console. The Oracle 
Enterprise Manager Login dialog box appears.

4. Select Launch standalone and click OK.

5. Double-click the Databases folder and the name of the database.

6. Log in with the following credentials, and then click OK:

Username:system

Password:manager

Service:host name (remote) or blank (local)
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Connect As: normal

7. Under Storage > Tablespaces, select System, Temporary, Agile_DATA1-5, and Agile_
INDX1-5. Verify disk space that each tablespace is using exceeds 90 percent. Make sure 
Agile_INDX4 has enough space for file content index synchronization.

8. When the Edit Datafile dialog box appears, increase the amount of available disk space, 
and then click OK.

Dynamic Versus Static IP Addresses
You can use dynamic IP addresses with "long-term lease" assignments, and static addresses, for 
Oracle systems. For best results, do not change the host name of computers in the system, and 
use their static IP addresses.

Database Backup
Database losses are costly and harmful, but they can and do occur. They can result from 
hardware failures, natural disasters, fire, power surges, and problems with administration and 
configuration. Whatever the cause, your best protection against business disruption and 
permanent data loss is an effective backup and recovery plan, applied automatically as much as 
possible. To this end, Oracle recommends instituting a scheduled backup of all file systems on 
all servers.

This chapter introduces several methods to back up and recover data. You will need additional 
information to adequately administer and protect your databases. It is recommended that you do 
a cost/benefits analysis to determine how often to back up critical data and to justify the labor, 
hardware, software, and storage costs involved. The following documents provide helpful 
information:

� Oracle Database Backup and Recovery Basics (see Oracle Database Backup and Recovery 
Basics - http://www.oracle.com/pls/db111/portal.portal_
db?selected=4&frame=#backup_and_recovery)

� Oracle Database Recovery Manager User's Guide (see Oracle Database Backup and 
Recovery Basics - http://www.oracle.com/pls/db111/portal.portal_
db?selected=4&frame=#backup_and_recovery)

� Oracle Database Concepts (see Oracle Database Concepts - 
http://download.oracle.com/docs/cd/B28359_01/server.111/b28318/toc.htm)

Note: Type the fully qualified host name of the computer in the Service 
field (or Host String in some cases) if you are not logging in on the same 
computer where you have installed Oracle or if you receive a TNS error 
message.

Note: If you need to increase the available disk space, double-click the 
value in the Size field.

Note: If possible, double the current disk space. If additional disk space is 
not available on the hard drive, consider upgrading your hardware.This is a 
preventive and proactive measure, but is not required. All Agile tablespaces 
automatically extend by 10MB whenever additional disk space is needed and 
available.
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You must be a member of the Oracle Technology Network (OTN) to have access to the site 
(becoming a member requires that you register at the site to gain access).

Backup and Recovery Strategy 
When you are planning a backup and recovery strategy, you must consider the following 
factors:

� Database availability

What is the database availability requirement for business operations? Is it required for 
7X24X365 availability or only during standard business hours?

According to the availability requirement, different database backup methods can be adopted. If 
the database cannot be shut down, a hot online backup is the only choice.

� ARCHIVELOG and NOARCHIVELOG mode

A database can run in ARCHIVELOG or NOARCHIVELOG mode. It is a best practice is to 
have your PRODUCTION database in archive log mode. DEVELOPMENT and TEST 
environments need not be in archive log mode since they can be refreshed using 
PRODUCTION.

When the database is in operation, all database changes are recorded in redo log files. If the 
database is running in ARCHIVELOG mode, these redo log files are archived in the database 
archive log destination and are referred to as archived redo log files. A database running in 
ARCHIVELOG mode provides better protection from data loss. It can be recovered up to the 
point of failure. To perform a hot backup, a database must be running in ARCHIVELOG mode.

The default configuration for the Agile database is NOARCHIVELOG mode. You can change 
the database to ARCHIVELOG mode following the instructions available in the initagile9.ora 
file. It is recommended that an Oracle DBA or Oracle support be available.

� Data loss tolerance

How much data can you afford to lose due to a database malfunction?

Can you afford to lose one day or one week's worth of data if a database malfunctions? Can you 
reenter user data if there is a database failure?

If your database cannot tolerate data loss due to failure, then a good data protection backup 
method must be adopted, such as hot or cold backup using ARCHIVELOG mode.

� Recovery time

How much time can you afford to spend recovering from a database malfunction?

Different backup methods have different recovery times. Physical methods for backup and 
recovery are much faster than logical backups, and backups to disk are much faster than to tape. 
Recovery is also much faster from disk than from tape.

� Technical skills

What are the technical skills of your database or systems administrator?

Some backup methods require more database knowledge than others. Standby databases require 
more technical skill than cold or hot backup.

Note: The documents are available on the Oracle Technology Network 
(OTN) Web site at: 
http://www.oracle.com/technetwork/documentation/agile-085940
.html.



Database Backup

7-4 Agile Product Lifecycle Management Database Install Guide

� Hardware or software investment

How much hardware or software investment do you want to put into the system?

Some advanced features, such as high availability, require more of an investment in hardware 
and software.

You can determine the safest backup method for your environment based on database 
requirements, database running mode, and your recovery scenario (described in the following 
table). However, the final decisions about the backup and recovery strategy you use are beyond 
the scope of this chapter. For detailed information to help you make these decisions, see the 
books listed on the previous page.

Implementing Backup Procedures
For best backup results, follow these guidelines:

� Schedule online backups when there is minimal database access.

� Test your backup strategy to see if it is effective; make changes if any area is weak.

� Plan to save at least one version back; choose to retain enough versions for your business 
needs.

� Perform database consistency checks just before export or after import.

� Back up the primary database before and after it is altered; if you save the original database 
creation scripts, you can use the same scripts to recreate it.

� For a distributed system, plan on coordinating backup procedures so each site can be 
backed up individually without destroying the integrity of the data at other sites.

Types of Backups
This section describes the following types of backups:

� Registry file backups

� System backups

� Standby database backups

� Standard database backups

System administrators often perform the first two types of backups, and database administrators 
(DBAs) perform the last two types of backups.

Scenario Backup methods

The database requires 7X24 uptime and cannot be 
shut down

Hot backup Export Database must be running in 
ARCHIVELOG mode

The database is available during regular business 
hours and can be shutdown

Hot backup Cold backup Export Database can 
running in NOARCHIVELOG or ARCHIVELOG 
mode

To recover up to the point of failure Hot backup Cold backup with ARCHIVELOG 
mode

To recover an individual user or table Export

For fast recovery Hot backup Cold backup
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Performing System Backups 
In general, system backups are performed on a small system. To this end, you will bring down 
the entire system, including all programs, data and log files. Usually, a system backup is run on 
a nightly basis. 

System backups are performed in two steps:

Step 1. Shut down and restart the system in the single-user or maintenance mod.

Step 2. Copy the system files as follows:

1. Shut down all active applications.

2. Shut down the relational database.

3. Stop the Agile Application Server process.

4. Back up all file systems to an alternate storage device.

5. Start the Agile Application Server process.

6. Start the system in multiuser mode.

7. Restart the database.

8. Restart applications as needed.

Using Standby Databases
The standby database feature maintains a duplicate database of your primary online database at 
the same location or at a remote site. (Both the standby database and the primary database must 
be running on the same hardware platform, operating system, and Oracle patch release.) A 
standby database acts as a backup when it resides locally, and is implemented as part of a 
database disaster recovery strategy when it resides at a remote site. The standby database has 
the following features:

� It is copied from the primary or current production database onto a system residing locally 
or remotely.

� It is mounted, but not open, and is in constant recovery mode.

� Redo log files generated from the primary database can be transported to the standby 
database, and the standby database can apply these logs to recover the database.

� In the event of a disaster, a standby database can be activated and fully functional as a new 
production database.

A standby database takes time to set up and configure. For more information on standby 
databases, see Oracle Data Guard Overview 
http://www.oracle.com/technetwork/deploy/availability/htdocs/DataGuardOver
view.html.

Performing Database Backups
It is recommended that you run your standard database backups on a daily basis. Databases 
backups can be:

�  Cold or offline, where the database is shut down before copying database-related files: 
control files, data files, redo log files, initial parameter file (initagile9.ora), spfileagile9.ora, 
and password file (pwdagile9.ora). A database running in ARCHIVELOG or 
NOARCHIVELOG mode can be backed up by a cold backup (NOARCHIVELOG mode 
permits only cold backups).
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� Hot or online, where a backup is performed while the database is open and users are 
accessing it. To perform a hot backup, a database must be running in ARCHIVELOG 
mode. When performing a hot backup, the database tablespace must first be put in backup 
mode, then the data file can be copied by the operating system. Once the data file has been 
copied, the database tablespace can be placed online again. This allows the database to be 
backed up tablespace by tablespace. The archived log files must be backed up regularly as 
these are needed for database recovery.

� A logical backup creates logical copies of database objects in a binary export file. Logical 
backups use the agile9 database utilities, agile9exp and agile9imp. When performing 
logical backups, a database must be open and running.

For best results, timestamp your backups and generate scripts to perform this automatically 
using the operating system task schedule command.

Performing Hot Backups
This involves backing up the archived log files. You must perform this on a regular basis 
because they are needed for database recovery

Performing Cold Backups
Cold backups are done on all the database-related files, including data files, control files, redo 
log files, the initial parameter file (initagile9.ora), the password file (pwdagile9.ora), and the 
server parameter file (spfileagile9.ora).

To perform a cold backup on all database-related files:
1. Shut down the database.

2. Use the operating system copy command to copy all of the database data files, the control 
file, the initial parameter file, the password file, and the archived redo log file (if the 
database is running in ARCHIVELOG mode) to the backup destination.

3. Restart the database.

Cold backups are done on all database-related files, including data files, control files, redo log 
files, the initial parameter file (initagile9.ora), the password file (pwdagile9.ora), and the server 
parameter file (spfileagile9.ora).

Database Import and Export
You can import and export a database using either of the following means, based upon your 
requirement:

� Oracle Data Pump - Ideal for very large Agile PLM databases. Enables very fast bulk 
data and metadata movement between Oracle databases. Uses high-speed, parallel 'expdp' 
and 'impdp' utilities to move data. The following utilities are included in the Agile PLM 
installation folder for import/export using Oracle Data Pump:

– agile9impdp

– agile9expdp

Note: Oracle EXP and IMP utilities do not export the ctxsys account. So, 
FTS objects will be recreated during an agile9 import.
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� Import / Export Utilities- Ideal for relatively small initial 'schema dumps' and for small 
databases. Uses the Oracle Database Server 'imp' and 'exp' utilities to move data. The 
following utilities are included in the installation folder for traditional import/export:

– agile9imp

– agile9exp

The import or export procedure for the Agile database remains the same in both cases. Only the 
utilities called are different, as listed above. These procedures are outlined in the following 
sections.

The import process includes the following actions:

1. Creating the Agile schema.

2. Organizing the schema.

3. Defining import parameters.

4. Running the import utility.

Creating the Agile Schema and Importing the Database
Before you import, ensure that you have taken a full backup of your Oracle database or of the 
Agile schema, described in "Exporting the Database" on page 7-12.

To create the Agile schema and import the database on Windows:
1. Confirm that the schema is valid. If you do not already have the maintenance scripts 

generated, run the database installer with the Generate database scripts only option 
selected, described in "Configuring the Agile Database on Windows". Follow on-screen 
prompts to complete script generation.

2. Next, to ensure that the schema is organized correctly, type the following in a Command 
Prompt window:

cd oracle\admin\<Oracle_SID>\create\<agile schema user>

recreateagile.bat

3.  Check import parameters in the .par file:

For traditional import: agile9imp.par

For Oracle Data Pump import: agile9impdp.par and agile9impdp_seq_trig.par

For more information on these parameters, see "Import Parameters" on page 7-9.

4. To import the database and recreate indexes and statistics, run the following batch file:

For traditional import: agile9imp.bat

For Oracle Data Pump import:agile9impdp.bat

5. After the batch file finishes running, type Exit to close the Command Prompt window.

Note: If you are prompted for the service name or host string, you must 
provide the fully qualified computer name.

Note: Running this command will drop the existing Agile schema (if any) 
and any data that it contains.
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To create the Agile schema and import the database on UNIX:
1. Log in as the user used to install the Oracle database software..

2.  Confirm that the database schema is valid.

3. Confirm that the user account name is new.

4. Make a backup of the existing database schema.

5. Change to the oracle user directory:

$ cd

6.  Copy agile9database from the agile9350db directory:

$ cp ./agile9350db/agile9database.sh

7. Edit the agile9database shell script, and find AGILE=agile.

8. Change agile to the new, unused account name.

9.  Save and close the file.

10. Run agile9database:

$ chmod u+x agile9database.sh

$ ./agile9database.sh

You are prompted to choose a database size. Enter D for demo, S for small, M for medium, 
L for large, or X for extra large, based on how you created the database initially.

The script creates several SQL scripts and Bourne shell scripts in the following directory:

$ORACLE_BASE/admin/$ORACLE_SID/create/<agile schema user>.

11. When the script finishes running, type the following:

$ cd $ORACLE_BASE/admin/$ORACLE_SID/create/<agile schema user>

12. Run recreateagile:

$ chmod u+x recreateagile.sh

$ ./recreateagile.sh

13.  Check import parameters in the .par file:

For traditional import: agile9imp.par

For Oracle Data Pump import:agile9impdp.par

For more information on these parameters, see "Import Parameters" on page 7-9.

14. To import the database and recreate indexes and statistics, run the following batch file:

For traditional import: agile9imp.sh

For Oracle Data Pump import:agile9impdp.sh

15. To import the schema and recreate indexes and statistics, run the following commands:

Note: For file content index synchronization, call Oracle Support Services.

Note: Running this command will drop the existing Agile schema (if any) 
and any data that it contains.



Database Import and Export

Managing the Database 7-9

For traditional import:

$ chmod u+x agile9imp.sh

$ ./agile9imp.sh

For Oracle Data Pump import:

$ chmod u+x agile9impdp.sh

$ ./agile9impdp.sh

For file content index synchronization, call Oracle Support Services.

Import Parameters
Import parameters are specified within the files listed in the table below. These files are located 
in the database instance folder along with the import utilities.

agile9imp.par

Parameter

Description

file

The file to import. The dump file schema version must match the latest agile schema version.

log

The import log file.

fromuser

The user account in the file that contains the data that will be imported. fromuser must exist in the 
dump file specified by the file.

touser

The user account where the data is being imported. touser must match the current value of 
%AGILE%; otherwise, importing the data may cause data corruption.

Note: Other parameters such as indexes, rows, ignore, grants, 
constraints, and statistics specify other import settings. Do not modify these 
parameters, and these settings should only be used when using the agile9imp 
utility. If a standalone imp is used, do not use these settings.

agile9impdp.par

Parameter

Description

directory

The directory object that identifies the location of the import files.

dumpfile

The dump file to import. The dump file schema version must match the latest agile schema version.

logfile

The import log file.
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Deleting an Instance of and the Database Files
Before creating a new instance, you must delete existing instances (such as agile9).

1.  Make sure the Oracle Listener and Agile9 services are running. (Agile9 is the Oracle 
service if your SID is Agile9.)

2. Start the Database Configuration Assistant.

3. Select Delete a Database, and click Next.

The instance you want to delete (Agile9) should appear in the Available Instances field.

4. Select the instance.

5. Type the username (sys) and password (oracle), if necessary.

6. Click Finish.

7. You are prompted to confirm the deletion, and then a message appears confirming that the 
instance has been removed.

8. Confirm that the agile9-related password file, spfile, and init files in the $ORACLE_
HOME/dbs folder on UNIX were deleted.

9. Confirm that the agile9-related password file, spfile, and init files in the %ORACLE_
HOME\database folder on Windows were deleted.

content

The data to import. The default value is data_only. To import to a new schema, first generate 
maintenance scripts for that schema, run recreateagile to create the schema objects, and then add the 
parameter remap_schema=<fromuser>:<touser>.

parallel

The number of import processes that should be run in parallel.

Note This parameter is supported only for Oracle Enterprise Edition. For other versions, this parameter 
must be removed from the .par file.

agile9impdp_seq_trig.par

Parameter

Description

directory

The directory object that identifies the location of the import files.

dumpfile

The dump file to import. The dump file schema version must match the latest agile schema version.

logfile

The import log file.

include

Specifies that sequences and triggers are to be imported.

Note: After dropping a database instance using the Database Configuration 
Assistant, the TEMP tablespace must be removed manually.
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Running SQL Scripts Against the Agile PLM Schema

To run an SQL script against an Oracle database on Windows: 
1. Create a new directory called "scripts" under the oracle\admin\agile9\create\<agile 

schema user> directory. Where agile9 is your Oracle SID.

2. Copy the SQL script to the scripts folder.

3. On the computer where Oracle is installed, start SQL Plus in a command prompt window.

4. Type the login ID and password (the defaults are agile and tartan).

5. Before running the script, create a spool file to record and contain the results from issuing 
the SQL script. At the SQL prompt type:

spool d:\oracle\admin\agile9\create\<agile schema user>\scripts\<file name>.lstFor 
example: spool d:\oracle\admin\agile9\create\<agile schema 
user>\scripts\averifyresults.lst

For example, if the SQL file to be run is oracle_averify90.sql, then name the spool file 
oracle_averify90.lst. You can also specify a drive or location other than what is shown in 
the previous example.

The drive and location specified are where the spool file will be saved.

6. Issue the command to run the SQL script by typing the following at the SQL prompt:

@d:\oracle\admin\agile9\create\<agile schema user>\scripts\<file name>.sqlFor 
example: @d:\oracle\admin\agile9\create\<agile schema user>\scripts\oracle_
averify90.sql

The file with the SQL extension is the name of the specific SQL file to be issued against 
the database. Depending on where the SQL file is located on the server, you will also 
specify the drive and location, which could be something other than the 
d:\oracle\admin\agile9\create\scripts shown in the example.

Note the process of the script as it is executed. When it is complete, there is the indication 
“commit, complete.”

7. At the SQL prompt, type the following: spool off

8. Close the SQL Plus window and exit SQL Plus.

Important: Before running a script, make sure you have a current backup 
(export) of your Agile database. For instructions on exporting (creating a 
DMP backup of your Agile database), refer to your Oracle documentation or 
Help system.

Note: The file with the LST extension is any file name that you want to use 
to identify the file that will contain these results. It is best and easiest to give 
the LST file the same name as the file name that is attached to the SQL file.

Note: The @ symbol must be typed directly in front of this command line.
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9. Locate and open the spool file created in step 5, if necessary.

The file can be opened within an application such as Notepad so that results can be viewed 
and printed, if necessary.

Exporting the Database
For maximum data security, you should use a cold backup. You can import the Agile schema 
DMP file whenever you need to restore a database or replicate it on another computer except 
for file content index synchronization because of its dependence on the file system.

If you are copying or moving the Agile schema to another computer, you need to set up the 
computer before importing the Agile schema.

You can perform either of the following types of export:

� Export the Agile schema alone - This is much faster than exporting the whole database.

� Full export - Export all the schemas in the Oracle database.

Exporting the Agile Schema from Oracle
Use the following procedures for Windows and UNIX respectively.

To export only the Agile schema on Windows:
1. Ensure that all users are logged off before shutting down the application server.

2. Open a Command Prompt window, and type the following:

d:

cd \oracle\admin\<Oracle SID>\create\<agile schema user>

3. Check export parameters in the .par file. 

For traditional export: agile9exp.par

For Oracle Data Pump export: agile9expdp.par

For more information on these parameters, see "Export Parameters" on page 7-14.

4. To export the database, run the following batch file:

For traditional export: agile9exp.bat

For Oracle Data Pump export: agile9expdp.bat

Note: In some cases where a change is being made to the database, you 
may need to stop and restart both Agile services for the change to take effect. 
If this is necessary, you will be advised at the time the script is provided. In 
the case of issuing scripts that do not make changes to the database scripts 
(for example, oracle_averify.sql scripts), restarting the Agile services is not 
necessary.

Important: If you are prompted for the service name or host string during 
the export, you must provide the fully qualified computer name.

Note: The following commands use the D drive. If you have installed 
agile9350db or Oracle on another drive, specify that drive letter.
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To only export the Agie Schema on UNIX:
1. Make sure all users are logged off. The easiest way to this end is to disconnect the server 

from the network.

2. Change to the directory where the Agile scripts are located:

$ cd $ORACLE_BASE/admin/$ORACLE_SID/create/<agile schema user>

3. Check export parameters in the .par file.

For traditional export: agile9exp.par

For Oracle Data Pump export: agile9expdp.par

For more information on these parameters, see "Export Parameters" on page 7-14.

4. To export the database, run the following commands:

For traditional import:

$ chmod u+x agile9exp.sh

$ ./agile9exp.sh

For Oracle Data Pump import:

$ chmod u+x agile9expdp.sh

$ ./agile9expdp.sh

The database export takes awhile. When it is complete, open the log file and see if the export 
was successful. If there were problems, call Oracle Support Services.

You can copy the successful export of expdat.dmp to another secure computer as a backup.

If you are unable to export empty tables, you have the following options to overcome this issue.

� Apply a patch to upgrade the database to version 11.2.0.3.0 or later a later version.

� Run ALTER TABLE ALLOCATE EXTENT on each empty table that is not exporting.

� Set the deferred_segment_creation parameter to FALSE in the database instance and 
recreate the schema.

Exporting the Full Oracle Database
The following procedure describe exporting the full Oracle database on a Windows and a 
UNIX environment.

To export the full Oracle database on Windows:
1. Make sure all system users are logged off. The easiest way to this is end is to disconnect 

the server from the network.

2. Open a Command Prompt window.

3. Set the character set:

NLS_LANG=AMERICAN_AMERICA.AL32UTF8

4. Type the following text with spaces and a triple set of quotes as indicated (do not press 
Enter until you have typed the entire text string):

expsystem/manager full=y file="""<drive>:\Agile9Tmp\<exp_filename>.dmp""" 
log="""drive:\Agile9Tmp\<exp_filename>.log"""

Agile recommends naming the export file expfull.dmp. For example:
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exp system/manager full=y file="""d:\Agile9Tmp\expfull.dmp""" 
log="""d:\Agile9Tmp\expfull.log"""

To export the full Oracle database on UNIX:
1. Make sure all system users are logged off. The easiest way to do this is to disconnect the 

server from the network.

2. Type the following command:

$ exp system/manager full=y file/home/oracle/agile9350db/ <exp_filename>.dmp 
log=/home/oracle/agile9350db/<exp_filename>.log

Agile recommends naming the export file expfull.dmp. For example:

exp system/manager full=y file=/home/oracle/agile9350db/expfull.dmp 
log=/home/oracle/agile9350db/expfull.log

The database export takes a while. When it completes, open the log file and see if the export 
was successful. If there were problems, call Agile Technical Support.

You can copy the successful export of expfull.dmp to another secure computer as a backup.

Export Parameters

Database Recovery
In the case of failure, database recovery uses a previous database backup to recreate a database 
that is as complete, accurate, and up-to-date as possible. Database recovery depends on the 
database backup method. Two backup methods are standard backup and logical backup.

� For standard backup, including cold and hot backup, database recovery requires the use of 
the operating system copy command to restore backed up data files.

agile9exp.par

file

The file to export.

log

The export log file.

owner

The user account that contains the data to export.

agile9expdp.par

directory

The directory object that identifies the location of the import files.

dumpfile

The dump file to export.

logfile

The export log file.

schemas

The names of the schemas to export.
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If the database is running in NOARCHIVELOG mode, there are no backed up archive log files. 
Recovery is to restore a previously backed up data file, control file, initial parameter file, and 
password file. No redo log files are applied and no database roll forward is needed. In this 
scenario, a database can be recovered up to the last backup.

 If the database is running ARCHIVELOG mode, database recovery is to restore previous 
backed up database files up to the last archived log files. When recovering a database, these 
archived log files are applied and the database is rolled forward. In this scenario, a database can 
be recovered up to the point of database failure.

� For a logical backup, a database recovery involves importing the database or schema from 
a previous export DMP file. For a logical backup, there is no roll forward involved.

Database recovery can be performed by using Oracle Recovery Manager.

Using Oracle Recovery Manager
You can use the Oracle Recovery Manager to perform an automatic recovery, restore the full 
database, restore a data file, or restore a control file.

The major advantage for Oracle Recovery Manager (RMAN) is that it can perform incremental 
database backup and recovery. Incremental backup and recovery is much faster than a full 
database backup and recovery, especially for large database systems. RMAN is more 
complicated to setup compared with a standard backup.
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Activity
A project activity in Agile Product Portfolio Management, such as a program, task, or phase.

Affected Files
Similar to Affected Items, these objects are EC files that are Design Release Candidates.

Agile Configuration Propagation (ACP)
Propagating existing configuration of PLM to the newly installed version of PLM.

Agile Content Service (ACS) 
ACS is an event-driven XML-based publishing service that makes the product record available 
to a wide variety of business applications and users, internally and across the global 
manufacturing network

Agile Destination
A package created by an Agile PLM system in the target PLM using Web Services to import 
from the Attachments tab of the package in the target system.

Agile Integration Services (AIS)
A collection of predefined Web Services in the Agile Integration Framework that enable 
communication between the Agile Application Server and disparate systems

Agile Product Portfolio Management
The Agile PLM project management solution that is integrated with the product information in 
PLM.

AI
Affected Items tab on Change objects in Agile.

Approved Manufacturer Parts List (AML)
List of approved manufacturer parts associated with an item.

Application Programming Interface (API)
A set of routines, protocols, and tools for building software applications. An API expresses a 
software component in terms of its operations, inputs, outputs, and underlying types.

Assembly
A product assembly lists the parts in a product and shows the substances and materials that 
comprise those parts. It is linked to specifications that can restrict how much of a particular 
substance that product assembly may contain
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Automated Transfer Orders (ATO)
Content published by Agile PLM users in real time with a content transfer order (CTO) or set 
up subscribers to automatically create automated transfer orders (ATO) based on a schedule or 
triggered by a workflow status change.

Baseline
A snapshot of a project, usually in its initial stage, used as a reference for future comparison in 
Agile Product Portfolio Management.

Bill of Material (BOM)
A hierarchical representation of a product that is made up of other products.

Bill of Substances (BOS)
A hierarchical list of substances that are contained in the parts and assemblies that make up a 
BOM.

Change Sequence
A series of three-digit numbers (001 through 099) that define the order in which DFCOs 
(Design File Change Orders) have been published for a specific Design or File Folder. Each 
Change Sequence number is associated with one specific DFCO and with the specific file 
folder version number in use when the DFCO is published.

Commodity
A class of goods that is in demand, that is supplied without qualitative differentiation regardless 
of supplier.

Computer-aided Design (CAD)
The use of computer systems to assist in the creation, modification, analysis, or optimization of 
a design. CAD software is used to increase the productivity of the designer, improve the quality 
of design, improve communications through documentation, and to create a database for 
manufacturing. CAD output is often in the form of electronic files for print, machining, or other 
manufacturing operations.

Contract (Price)
This is a subclass of the Published Prices class. Contract prices are prices provided by the 
supplier for a specific item or manufacturer part. This price information applies only for the 
specified duration and can apply to any project.

Co-Sourcing
The process of leveraging product cost across suppliers. 

Deliverable
A unit of work required for a project's success, usually fulfilled by generating a digital file. 
(Word processing documents, spreadsheet documents, PDFs, presentation documents, and so 
on.) Deliverables can also be Agile PLM objects and processes. Also called ’content’ in Agile 
Product Portfolio Management.

Design Change Order (DCO)
A Change Order subclass that is available when the effected File Tab is enabled and provides 
access to all Agile PLM Workflow functions.
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Design File Folder
An EC file folder that is integrated with CAD and PLM files, providing full access to PLM 
Workflow function.

EC Client
A Java-based UI to access, administer and operated the EC solution.

Engineering Collaboration (EC)
An application that provides data and process integration between CAD applications and Agile 
PLM. It allows CAD designers and engineers to capture and control the data representing a 
primary source of the product record.

Engineering Collaboration Order (ECO)
An object that carries with it all the proposed changes to a product and/or its BOM. When 
approved and implemented, the proposed changes become effective.

Extensible Markup Language (XML) 
A markup language that defines a set of rules for encoding documents in a format that is both 
human-readable and machine-readable

File Manager
The File Manager manages files in a repository or vault in the file system and provides a place 
to store and retrieve files locally or remotely. You can install it on the same server as the Agile 
Application Server or on a separate one. You can also install the File in a redundant 
configuration and/or distributed across geographic regions. 

File Transfer Protocol (FTP)
A standard network protocol used to transfer computer files from one host to another host over 
a TCP-based network, such as the Internet.

Fully Qualified File Name
The exact name of a file on a computer that is completely specified such that it is unambiguous 
and cannot be mistaken for any other file on that system.

Fully Qualified Path Name (FQPN)
The full path of a resource, directory or file, stored in a computer. It is composed by the full 
path to the resource and its syntax depends on the operating system.

Gantt Chart
A project management tool that shows project activities and schedule as a bar chart. The chart 
lists project activities in sequence, and presents critical information such as the start and end 
dates of each activity, as well as interdependencies between activities.

Item Master
The product record. It is the entire collection of Items - Parts, Documents, and any other 
user-defined subclasses of the Items class maintained under change control in the Agile system.

Java Message Service (JMS)
The Java Message Service (JMS) API is a Java Message Oriented Middleware (MOM) API for 
sending messages between two or more clients.

Lifecycle Phase
Current state in an object’s workflow.
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LRR
Latest Released Rev - concerning a Part or Document. 

Non Cancelable Non Returnable (NCNR) 
Applies to an item. NCNR can be a Yes or No, depending on the supplier. You can ask for the 
NCNR information in the supplier response. This is one of the critical factors in finding the best 
deal among the supplier responses.

PDX
See Product Definition eXchange (PDX).

PLM
See Product Lifecycle Management (PLM).

Percent allocation or % allocation
The percentage of a resource's time allocated to a specific task or tasks in Agile Product 
Portfolio Management..

Percent complete or % complete
Amount of time and effort expended on a project measured as a percentage of the time and 
effort required to complete the whole project. Used in Agile Product Portfolio Management.

Product Definition eXchange (PDX)
A standard designed for the e-supply chain. This standard is based on the XML format because 
it provides a simple yet powerful and flexible way to encode structured data into a format that 
is both human- and computer-readable. In PLM, PDX packages contain product content, such 
as items.

Product Lifecycle Management (PLM)
The process of taking parts/documents from inception to production to phase-out, and all the 
stages in between.

Protocol
A system of digital rules or agreed-upon format for data exchange within or between devices. It 
determines the type of error checking and data compression used.

Published Price
This is a subclass of the Published Prices class. Published prices are prices provided by the 
suppliers in response to an RFQ and published from the project. The published price 
information can also be used in other projects.

Price
An object that carries with it all the proposed changes to a product and/or its BOM. It can be 
approved and implemented to make the proposed changes effective.

Price Change Order
It is an object that carries with it all the proposed changes to a price. It can be approved and 
implemented to make the proposed changes effective.

Quote History
A subclass of the Quote Histories class. Quote history prices are the stored prices from supplier 
responses that you can use. Any change in the response line of an RFQ is stored in the 
historical response and is usable at any time.
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Request for Information (RFI)
A material declaration that lists the parts in a product assembly and shows the substances and 
materials contained in the part.

Request for Quote (RFQ)
A standard business process whose purpose is to invite suppliers into a bidding process to bid 
on specific products or services.

Request for Proposal (RFP)
A solicitation, often made through a bidding process, by an agency or company interested in 
procuring a commodity, service or valuable asset, to potential suppliers.

Response Line
A response line has information about only one item. The negotiation of price and terms for 
items is dealt with in a response line.

Resource Pool
A group of users who can be bulk assigned as resources for a particular project or task in Agile 
Product Portfolio Management.

RFQ Response
A medium of communication between the user and the supplier. One response from a supplier 
can contain multiple response lines for different items. Price data is added to the project 
automatically when the supplier submits the response.

Schedule Editor
The scheduling engine that handles updates to the project schedule in Agile Product Portfolio 
Management.

Schema
In computer programming, a schema is the organization or structure for a database. The activity 
of data modeling leads to a schema.

Software Development Kit (SDK or "devkit")
A set of software development tools that allows the creation of applications for a certain 
software package, software framework, hardware platform, computer system, video game 
console, operating system, or similar development platform.

Sourcing Project
The entry point of sourcing and product pricing. A sourcing project tracks data required for 
sourcing and pricing, to perform data analysis for effective pricing.

Standard Cost
Applies to an item. This is the market cost of the item. It is site-specific. The standard cost is 
for a unit.

Supplier
A supplier of one or several commodities.

Target Cost
Applies to item. This is the expected cost of the item by you or the supplier. This can be a 
percentage of the standard cost. Target cost is for a unit.
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Timesheet
The time entry system in Agile Product Portfolio Management, used to track actual hours spent 
by resources on project activities and to calculate corresponding labor cost. 

Top Level Assembly (TLA)
The level in a BOM that indicates the ultimate product being manufactured. 

Transfer order
Every time Agile Content Service (ACS) publishes product content, it produces a transfer order 
that keeps track of what, where, and when product content is transferred.

User Productivity Kit (UPK)
The Oracle online help system used in some Oracle products.

Web Service Extensions (WSX)
A Web service engine that enables communication between Agile Product Lifecycle 
Management system and disparate internal and external systems.

XML
See Extensible Markup Language (XML).

XML Schema
Description of a type of XML document, typically expressed in terms of constraints on the 
structure and content of documents of that type, above and beyond the basic syntactical 
constraints imposed by XML rules.
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